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Welcome 
This award-winning application uses proprietary CalliGrapher technology to bring you 
unprecedented recognition accuracy and ease of use to your Microsoft Windows 
powered portable device.  CalliGrapher 6.0 recognizes all handwriting, be it 

, 

, 

or 

.  

Additionally, you can enter equations such as  

 

for use with CalliGrapher’s RiteCalcTM, the calculator that works with your natural 
handwriting.  As you can see, CalliGrapher lets you interact with your mobile device on 
your terms, not the computer’s! 

CalliGrapher 6.0 employs advanced fuzzy logic and neural net techniques that allow it 
to recognize your handwriting with unparalleled accuracy and speed.  In addition to 
recognizing letters, numbers, and words, CalliGrapher recognizes common symbols and 
various control ‘gestures’ (explained later in this manual).  CalliGrapher 6.0 introduces 
a new feature – PenCommander, which allows a user to perform many common tasks 
using simple handwritten commands. 

Many Windows Microsoft powered devices have small, cramped keyboards or no 
keyboard at all.  CalliGrapher frees you from the constraints imposed by these devices 
and unleashes their power. 

Please visit our Web site at http://www.phatware.com to get the latest news on 
CalliGrapher and other PhatWare products. For the latest CalliGrapher information, 
you may go directly to http://www.paragraph.com/calligrapher.html. 

Please feel free to contact us with your questions and comments by emailing us at 
support@phatware.com.  
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Before Getting Started 

Conventions 

This manual uses several notational conventions to present information of special 
importance.   

NOTE: Notes highlight helpful and important things to keep in mind.  These include 
things like tips and tricks, shortcuts, and hints.  

Lists of items, points to consider, or procedures that do not need to be performed in a 
specific order appear in bullet format: 

! 

! 

Item 1 

Item 2 

Procedures that must be followed in a specific order appear in numbered steps: 

1. Perform this step first 

2. Perform this step second 

Specific keyboard keys are depicted in square brackets and are capitalized, for 
example: [ESC].  If more than one key should be pressed simultaneously, the notation 
appears as [KEY1]+[KEY2], for example [ALT]+[F4]. 

Buttons and knobs are depicted in round brackets and are capitalized and italicized, 
for example: {RESET}. 

NOTE: The notation [tap] signifies a stylus or finger tapping a touch screen.   

Screen prompts are displayed in bold Courier font, for example: Start 

Items you must type appear in standard Courier font, for example: 
cd\letters\business\legal [ENTER] 

Manual Layout 

This manual is laid out as follows: 

! Part One - Getting Started: This part details the CalliGrapher features, system 
requirements, and installation process. 

! Part Two - Tutorials: Many people prefer to learn by doing.  This part includes a 
few tutorials to help you get up and running with CalliGrapher quickly.  Once you 
have finished the tutorials, you will want to read the reference chapters, which 
explain all of CalliGrapher’s many features.  Of course, you may also choose to 
read the rest of the manual first and do the tutorials later. 
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! Part Three – CalliGrapher Reference: This part provides detailed instructions on 
using the CalliGrapher functions 

! Part Four - Customizing CalliGrapher: Instructions on customizing CalliGrapher 
to suit your individual needs and preferences. 

! Part Five - PenCommander Reference: This chapter explains how to create 
custom PenCommands. 
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Part One: Getting Started 
This chapter details the CalliGrapher 6.0 features, system requirements, and installation 
process. 

CalliGrapher Features 

CalliGrapher is a powerful handwriting recognition engine.  Some of its advanced features 
include: 

! Natural handwriting recognition: CalliGrapher recognizes print, cursive, and mixed 
script as well as arbitrary symbol strings and control ‘gestures’. 

! Immediate usability: Unlike many handwriting recognition programs, CalliGrapher is 
ready to run right out of the box with no training required.  You can, however, 
customize CalliGrapher to your personal handwriting style, thereby increasing 
CalliGrapher’s already superb accuracy and speed. 

! Built-in dictionary: CalliGrapher recognizes words from its integrated dictionaries.  This 
includes a main dictionary containing approximately 65,000 words and a custom user 
dictionary.  CalliGrapher also recognizes non-vocabulary words like personal names, 
geographical names, and arbitrary handwritten symbol strings. 

! ScratchPad drawing and note taking: This feature allows you to have a virtual scratch 
pad at the click of a button.     

! Deferred Recognition: You can also write while in drawing mode and have CalliGrapher 
convert your handwriting into typed text at a later time. 

! CalliGrapher Keyboard: This virtual keyboard gives you all the functionality of a built-in 
keyboard when you cannot access the keyboard on your mobile device, or even when 
your mobile device has no keyboard at all. 

! RiteCalc handwriting calculator: Simply write an equation, and let RiteCalc do the 
math. 

! Extensive correction interface: By pointing out CalliGrapher’s mistakes, you can 
improve its performance. 

! Spell Checker: This feature works with practically any application for Microsoft 
Windows-powered mobile devices. 

! PenCommander: Write a word and draw a circle around it to launch an automated 
script (PenCommand).  Using PenCommands, you can perform a wide spectrum of tasks 
from simple text substitutions and launching applications to calling a function from any 
system or user-defined DLL. You may use the many pre-defined PenCommands that are 
included with CalliGrapher and may also define your own in order to automate 
frequent tasks and create new functionality for your mobile device. 
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System Requirements 

CalliGrapher requires the following minimum configuration: 

♦ Microsoft Windows-powered Pocket PC, Handheld PC, or Palm-Size PC with a MIPS, 
SH3, SH4, or ARM processor. 

♦ Microsoft Windows CE 2.11 or higher 

♦ 1.5Mb – 1.7Mb (depending on the device) free storage space on your mobile device 

♦ 4Mb free RAM 

♦ IBM-compatible PC with Microsoft ActiveSync 3.0 or later is required for installation 

Please note that the above represents minimum requirements only.  CalliGrapher performs 
better on systems exceeding the listed requirements. 

Uninstalling older versions of CalliGrapher 

As with any software installation, it is recommended that you close all open applications 
and back your data up prior to beginning the CalliGrapher setup process.  Use the following 
procedure to install CalliGrapher on your system: 

You must remove previous versions of CalliGrapher or Microsoft Transcriber if installed.  To 
do this: 

1. Disconnect the mobile device from the Desktop PC (if connected).  

2. Choose the Settings/Control Panel (H/PC only)/Remove Programs item from 
the Start menu to run Control Panel.  

3. When the Remove Programs Properties dialog box appears, locate the 
CalliGrapher entry in the list box.  

4. Tap on it to select it.   

5. Tap the Remove button to remove the CalliGrapher application.  

6. Reset your mobile device to finish the uninstallation. 

NOTE: If your mobile device came pre-loaded with an older version of CalliGrapher, you 
will not be able to remove the old version, and it will not appear in the Remove 
Programs dialog box.  

Installing CalliGrapher 
1. Connect your mobile device to your host PC and establish a partnership using Microsoft 

ActiveSync. 

2. Run the CalliGrapher Setup application (calligrapher60e.exe) on your desktop PC, and 
follow the on-screen prompts.  CalliGrapher Setup extracts the CalliGrapher files and 
copies them to the selected directory on your host PC.   

3. CalliGrapher Setup will copy the program files to your mobile device. 
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NOTE: If your mobile device came pre-loaded with an older version of CalliGrapher, the 
new installation will attempt to overwrite the old one.  However, because the original 
version is contained in ROM, your older version will be restored if for some reason your 
mobile device loses its data (such as a dead battery or hard reset). 

Registering CalliGrapher 

When you run the CalliGrapher for the first time the Register CalliGrapher dialog box 
will appear (see picture below). If you have already purchased CalliGrapher, please enter 
the registration code* into the edit field and tap the Register Now button. If you 
downloaded a 30-day free trial version of CalliGrapher 6.0, just tap the Register Later 
button. While using the CalliGrapher in the trial mode, this dialog box will appear every 
time you start CalliGrapher until you enter the registration code. After the trial period 
expires, CalliGrapher will no longer work and you will be able to access the Register 
CalliGrapher dialog box only, until you enter the valid registration code. 

 

 
Register CalliGrapher dialog box. 

* The registration code is located in the purchasing confirmation email, which is 
automatically emailed to you, only when you purchase the product. If you have purchased 
CalliGrapher in a retail box, the registration code can be found on the CD-ROM cover. The 
Registration code is a case-sensitive alphanumeric string with no spaces inside, which has 
the following format XXXX-XXX-XXXXXXXXX. If you have problems finding the registration 
code please contact PhatWare technical support. 

If you have downloaded and used the trial version of CalliGrapher and then decided to 
purchase it, you do not need to download or reinstall CalliGrapher. After you receive your 
registration code, restart CalliGrapher and when the Register CalliGrapher dialog box 
appears, enter the code in the space provided and tap the Register Now button. 
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Important! It is imperative that you keep the CalliGrapher Registration Code in a safe 
place. You will need it for future product upgrades and to contact product technical 
support. We strongly recommend filling out and submitting the Product Registration Form 
on our web site at http://www.phatware.com/register to ensure that you are registered 
with PhatWare Corp. 

Launching CalliGrapher 

To launch CalliGrapher, tap Start>Programs> CalliGrapher and tap the 
CalliGrapher icon.  The pen  and marker  icons appear in the notification area of 
the Windows taskbar on Palm-Size and Handheld PCs and in the Today window on Pocket 
PCs. (The pen  icon only appears in the notification area of the Windows taskbar on 
Pocket PCs when not in the Today window.)   Tapping either of these icons and pausing for 
a moment opens the CalliGrapher Main Menu. 

NOTE: On a Palm-Size PC or a Pocket PC, you can also start CalliGrapher using the System 
Input Panel (SIP) as shown below: 
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NOTE: In the example below, the Recognition (pen) icon is shaded, while the ScratchPad 
(marker) icon is not.  Shaded icons denote active CalliGrapher modes.  Thus, in this 
example, CalliGrapher is in Recognition mode.  For a full explanation of the various 
CalliGrapher modes, please refer to the CalliGrapher Modes section, below. 
 

 

Taskbar Icons (for Palm-Size and Handheld PCs only) 

The CalliGrapher icons in the Windows taskbar notification area indicate the currently 
selected CalliGrapher mode and allow you to access the CalliGrapher Main Menu.  Briefly 
tapping an icon toggles the selected mode on and off.  Tapping any CalliGrapher icon and 
pausing launches the CalliGrapher Main Menu. 

Please refer to the CalliGrapher Main Menu and CalliGrapher Modes sections, below. 

You can customize the icons that appear in the Windows taskbar notification area.  For 
more information, please refer to the Customizing CalliGrapher section, below.
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Part Two: CalliGrapher Tutorials 
These tutorials cover a few of the most common ways in which people use CalliGrapher.  
To use them, simply turn on your mobile device and follow along!  Be sure to read the rest 
of the manual for complete details on how CalliGrapher works once you are finished with 
the tutorials. 

NOTE: The tutorials in this manual are designed to be generic.  CalliGrapher will function 
with practically any text editing software. 

Tutorial One: The Basics 

This tutorial introduces you to some of Calligrapher’s basic features.  Simply follow the 
steps outlined below to experiment and see for yourself some of the many things you can 
do using CalliGrapher: 

1. Launch both your text editing application and CalliGrapher on your mobile device. 

2. Make sure the pen icon is shaded (tap it if necessary) and write the following on your 
screen.  Try to write a bit more neatly that normal, and use larger letters until you get 
used to how the program responds to your input.  This will not affect CalliGrapher’s 
accuracy; rather, it will help introduce you to the program.  Write The quick brown 
fox jumps over a lazy dog. 

 

3. Select jumps over a lazy dog and use the Backspace gesture as shown below. 
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4. The selected text is erased. 

 

5. Now, insert a carriage return (equivalent to pressing [ENTER]) by using the Return 
gesture. Make sure that the horizontal part of the gesture is at least twice as long as 
the vertical part. 

 

6. Note that the cursor moves down one line. 

 

7. Now use the Erase gesture (straight line from right to left) to erase the carriage return 
and move back to the top line. 

8. Tap the word brown between the r and the o to position the cursor, and use the Space 
gesture.  The space gets inserted. 
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9. The space is added. 

 

10. Use the Erase gesture to remove the space. 

11. Select the word quick and use the Case Change gesture. 

 

12. This turns the word quick to QUICK. 

13. To undo the previous action, use the Undo gesture. 

 

14. The word reverts to lower case. 

 

15. You may use your stylus to change individual letters.  For example, highlight the letter 
b in brown and write the letter c. 
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16. The word changes. 

 

17. You may also select and replace entire words.  For example: 

 

18. This produces the following result: 

 

Tutorial Two: Drawing 

CalliGrapher is not just limited to text.  ScratchPad allow you to do almost anything, such 
as taking down directions to your office, making notes, or drawing a portrait of your cat: 

1. Start CalliGrapher on your mobile device and tap the marker icon to enter ScratchPad 
mode. 

2. To draw your cat, using the buttons at the top of the screen, select your line width, 
color, etc.  If you notice you need to change the flower, simply draw a line crossing all 
flower petals you wish to remove and pause with your stylus resting on the screen at 
the end of the line: 
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3. In a moment, the petals disappear. 

 

Tutorial Three: Correcting Text 

What if you make a mistake while writing?  No problem.  CalliGrapher allows you to correct 
mistakes quickly and easily as shown in this tutorial: 

1. Launch both your text editing application and CalliGrapher on your mobile device. 

2. Write The quick brown fox.  If CalliGrapher recognizes the above text correctly, 
keep writing until it mis-recognizes a word, for example: 
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3. Highlight the sentence and use the Correction gesture to launch the Correction 
Window.  Be sure to enter the gesture correctly (move the stroke from left to right and 
make the gesture large, with the right leg much higher than the left one as shown 
below). 

 

4. The Correction Window appears. 

 

5. Tap the word frown and note that a caret appears where you tapped; this is where 
changes will occur.  Either tap the caret or double-tap the selected word to bring up a 
list of suggested replacements. 

 

6. If the correct word is in the list (in this case brown), select it to make your changes. 

7. If the correct word is not in the list, simply correct the misspelled word manually by 
highlighting the incorrect letter and writing the correct letter.  Tap OK once you are 
finished making changes. 
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Tutorial Four: Beyond the Basics 

Our fox from the previous tutorials is not done yet.  In this tutorial, you learn more about 
CalliGrapher’s ‘gestures’ and spell-checking capabilities. 

1. Launch both your text editing application and CalliGrapher on your mobile device (or 
simply continue from the previous tutorial). 

2. Write or type the following sentence: The quick broun fox jumps over a lazy 
dog.  The misspelling is intentional. 

3. Use the Correction gesture. 

 

4. Because you have no text selected, the entire sentence will transfer to the Correction 
window. 

 

5. Double-tap the misspelled word (or tap the caret) to bring up the list of suggested 
replacements. 

 

6. Select the desired word, which replaces the word in your sentence. 
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7. Click OK.  The sentence is now correct. 

 

8. Select the word brown by drawing a single line across it from left to right and holding 
for a moment. 

 

9. The word  brown is selected. 

 

10. Now erase the word by drawing a single line from right to left.  The result appears 
below: 

 

11. To capitalize a letter, draw a single vertical line from the base of the letter whose 
case you wish to change to the top. 
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12. The result is as follows: 

 

13. To close the Correction window and accept the edits, tap OK.  Tap X to close the 
Correction window and reject your edits. 

Tutorial Five: PenCommander 

PenCommander technology adds a whole new dimension to CalliGrapher by allowing you to 
perform a wide variety of simple and complex tasks simply by writing them.  No more 
tapping through endless menus and icons!  This tutorial introduces you to some of the many 
things you can do using PenCommands: 

1. Enter some text in a document, then write the word all and draw a circle around it. 

 

2. The text is selected.  Now write cut and draw a circle around it. 
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3. The text is cut from the current document and placed in the Windows clipboard.  To 
restore it, simply write paste and circle it. 
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4. The text reappears: 

 

Please refer to the sections CalliGrapher Reference and PenCommander Reference, below, 
for complete information on how PenCommander can revolutionize the way you use your 
PDA.
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Part Three: CalliGrapher Reference 
This part explains how to use CalliGrapher’s many features and how to customize the 
software to suit your individual needs and preferences. 

CalliGrapher Main Menu 

Access the CalliGrapher Main Menu by tapping either the pen or marker icon in the taskbar 
notification area and pausing for a moment.  The CalliGrapher Main Menu appears as 
follows: 

 

The Main Menu contains the following items: 

! Mode switches: Check the appropriate mode to toggle it on and off.  This is the same 
as tapping the taskbar icons.  Please refer to the CalliGrapher Modes section, below, 
for complete information on using the various CalliGrapher modes. 

! Sound On: Check this box to hear brief sounds at various events while using 
CalliGrapher.  Clear it to disable sound. 

! Show/Hide IconBar: On Palm-Size PCs or Pocket PCs, this option toggles the 
CalliGrapher Icon Bar in the SIP area when CalliGrapher is active.  Please refer to the 
CalliGrapher Icon Bar section, below. 

! Options: Tap here to open the CalliGrapher Options Menu.  For more information, 
please refer to the Customizing CalliGrapher section, below. 

! Shape Selector: This option allows you to tailor CalliGrapher to better recognize your 
unique handwriting.  Please refer to the Customizing CalliGrapher section, below. 
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! PenCommander: This opens the PenCommander Editor, which allows you to create and 
edit both new and existing PenCommand macro commands.  Please refer to the Part 
Five: PenCommander Reference section, below. 

! Help: Opens CalliGrapher Help. 

! Close CalliGrapher: Closes the CalliGrapher application. 

CalliGrapher IconBar 

On Pocket PC and Palm-Size PC devices, CalliGrapher has a special toolbar that appears in 
the CalliGrapher SIP panel.  Its buttons duplicate the functions of the CalliGrapher main 
menu, providing one-click access to the most important functions.  The numbers beneath 
the icons correspond to the descriptions below. 

NOTE: The Icon Bar is not available on Handheld PC devices.  Instead, an Icons tab allows 
you to choose which CalliGrapher icons appear in the Windows Taskbar notification area.  
See the section Icons Tab, below. 

 

The CalliGrapher Icon Bar includes the following buttons:  

! Writing orientation (1): The arrow points perpendicular to the currently selected 
writing direction.  You may choose from six possible orientations. 

NOTE: To enhance recognition accuracy, be sure to write and gesture in the selected 
direction. 

! Recognition mode (2): There are three recognition modes available: 

♦ General (a): supports all kinds of writing (default) 

♦ Capitals (A): converts all writing to upper case 

♦ Numerals (12): only recognizes digits, punctuation, and selected letters (such as 
AM, PM, etc.) 

! Open CalliGrapher Keyboard (3): displays the CalliGrapher keyboard.  Please refer to 
the CalliGrapher Keyboard section below. 

! Correct Selected Text (4):  Displays the Correction Window.  Please refer to the 
Correcting Text section below. 

! Correct All Text (5):  Displays the Correction Window.  Please refer to the Correcting 
Text section below. 

! Open PenCommander Editor (6): launches the PenCommand Editor.  Please refer to the 
PenCommander Reference section below. 

! Open CalliGrapher Menu (7):  Displays the Main Menu.  Please refer to the section 
CalliGrapher Main Menu above. 

! Help (8): opens CalliGrapher help 

! Close CalliGrapher (9): exits all CalliGrapher applications.  You will be prompted 
before exiting. 
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You may enable or disable the CalliGrapher Icon Bar using either the General tab within 
the CalliGrapher Options dialog or the CalliGrapher Main Menu. 

CalliGrapher Keyboard 

CalliGrapher includes a soft keyboard, which provides all of the functionality of a hardware 
keyboard. 

There are three ways to open the CalliGrapher keyboard: 

! 

! 

! 

Tap the Keyboard icon in the taskbar 

Tap the Keyboard icon in the CalliGrapher Icon Bar. 

Draw the Quick Correct gesture when no text is selected. 

Please refer to the section Icons Tab, below, for information on enabling the Keyboard 
Icon. 

If the CalliGrapher keyboard was invoked by tapping the Keyboard icon, the following 
CalliGrapher Keyboard appears: 

 

You can drag the keyboard to anywhere on the screen.  Simply tap the key of your choice.  
It will have the same effect as typing the same key using a built-in keyboard.  If you are 
typing words, you will see a list of suggestions appear in the pull-down window on the top 
of the keyboard.  This can help save time when typing common words. 

NOTE: The Zoom button will not appear on the keyboard toolbar if expanding the keyboard 
would cause it become larger than the device screen. 

The keyboard disappears once you select a punctuation symbol unless you use the Pin 
button in the upper left corner to make it stay. 

The special function keys (light blue) remain pressed until you press another key.  This 
allows you to use control and other functions.  For example, you could tap [ALT], which 
remains pressed, followed by [F] ([ALT] pops up after you press [F]), and then [S] to 
save a file using most Microsoft Windows powered applications. 

You can perform standard calculations using the CalliGrapher Keyboard. Type in a 
mathematical expression followed by the equal sign (=) and see the result appear in the 
suggestion window (e.g. 23+7*8=).  Please refer to the RiteCalc section, below, for more 
details about the functions and limitations of the calculator feature. 

In addition to entering text or numbers, you may need to use the 
CalliGrapher Keyboard to add a punctuation symbol to text that has 
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been already written.  To simplify this frequent operation, use the Quick Correct gesture 
(please refer to the Quick Correct Gesture section, below) with no text selected to open 
the CalliGrapher Keyboard in Punctuation layout:  

In Punctuation layout, the Calligrapher Keyboard has the following four buttons from left 
to right: 

! 

! 

The keyboard disappears once you select a punctuation symbol unless you use the Pin 
button in the upper left corner to make it stay. 

The Zoom button doubles the size of the keyboard. 

NOTE: The Zoom button will not appear on the keyboard toolbar if expanding the keyboard 
would cause it become larger than the device screen. 

! 

! 

The Keyboard button opens the full keyboard. 

In either layout, tapping the Exit button in the upper right corner closes the 
CalliGrapher Keyboard.  Upon reopening, the keyboard will remember its last position.  

CalliGrapher Modes 

CalliGrapher operates in one of three modes: 

! 

! 

! 

Recognition 

ScratchPad 

Off 

This section discusses each mode in detail. 

Recognition Mode 

When in Recognition Mode, CalliGrapher interprets your drawing on the screen as 
handwriting.  CalliGrapher recognizes the handwriting and sends the results to the 
currently active application window.  Single and double taps will still work, meaning you 
can access menus, icons, and windows while in Recognition Mode.  When CalliGrapher is in 
Recognition Mode, the pen icon in the Windows taskbar will appear shaded, and on a PPC 
device the SIP panel window is active and IconBar is present (if this option is selected). 

Use one of the following methods to enter Recognition Mode: 

! 

! 

Select Recognition Mode from the CalliGrapher Main Menu. 

On a Handheld PC, tap the pen icon  in the Windows taskbar notification area, and 
on a Palm-Size or Pocket PC, click the SIP panel window. 

You may select text while in Recognition Mode by following the instructions contained in 
the Selecting Text section, below. 
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ScratchPad Mode  

This mode allows you to draw pictures, jot text notes, or put a mix of pictures and 
handwritten text on a virtual scratch pad.  CalliGrapher will not attempt to recognize pen 
input in ScratchPad Mode unless you specifically request this.  This mode has many uses: 
for example, you can draw a quick pictorial diagram with accompanying text.  You may 
also write text notes on your screen and have CalliGrapher recognize your notes later, as 
opposed to the real-time recognition offered by Recognition Mode. 

When CalliGrapher is in ScratchPad Mode, the marker icon in the Windows taskbar will 
appear shaded and you will see a virtual piece of paper with the ScratchPad toolbar over it 
(see below). 
Activate ScratchPad Mode using the following methods: 

! 

! 

Select ScratchPad Mode from the CalliGrapher Main Menu. 

Tap the marker icon  in the Windows taskbar (on Handheld PCs & Palm-Size PCs). 

! Tap the marker icon  in the Today window (on Pocket PCs only) (if selected in the 
Options dialog box). 

When CalliGrapher is in ScratchPad Mode, simply draw whatever you need on the presented 
virtual pad paper.  To delete one or more strokes, draw a line across the unwanted 
stroke(s).  Pause a moment without lifting your stylus from the screen.  You will hear a 
sound, and the selected stroke(s) will disappear. 

Off Mode 

When none of the CalliGrapher icons in the Windows taskbar notification area are selected, 
e.g. they do not appear shaded or (on a Palm-Size PC device) the SIP panel is in the OFF 
state, CalliGrapher is suspended.  While suspended, CalliGrapher does not process mouse 
or pen activity and does not affect the behavior of your mobile device. 

21 



CalliGrapher 6.0           CalliGrapher Reference 

ScratchPad Toolbar  

         

Toolbar on Handheld PCs and Palm-Size PCs    Toolbar on Pocket PCs 

The ScratchPad toolbar appears on top of the ScratchPad Window.  It includes the following 
buttons (numbers underneath the buttons correspond to their descriptions below): 

1. Tools Menu:  Commands for New Ink note, and numbers 2,3,4,9, and 10 (see below) 

 

2. Clear Ink (1): clears the current drawing. 

3. Load Ink Note (2): opens an existing ScratchPad drawing. 

! To load an Ink note: tap the Load Ink Note button on the ScratchPad toolbar or 
open the CalliGrapher Main Menu and select Load Ink File.  This opens the 
Open Ink File selector, which allows you to specify a filename and a file location. 

4. Save Ink Note and Save As Ink Note (3 + 4): saves your notes. 

! To save an Ink file: Once you are finished, click the Save Ink Note or Save As 
Ink Note button on the ScratchPad toolbar.  This opens the Save Ink As dialog, 
which allows you to specify a filename (a default name will be suggested to you) 
and a file location.  Once the file is saved the first time, clicking on Save Ink 
Note will automatically save the ScratchPad using the same filename, without 
opening up the dialog.  This uses the standard self-explanatory Windows interface. 

5. Horizontal grid (5): shows horizontal lines on the ScratchPad virtual paper. 

6. Vertical grid (6): shows vertical lines on the ScratchPad virtual paper. 
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7. Choose color (7): opens the pen color selection toolbar. Tap on the desired color 
button or (on Handheld PCs and Palm-Size PCs only) tap ‘X’ to close the color selection 
toolbar without changing the current pen color. 

 

8. Pen width (8): opens pen width selection toolbar. Tap on the desired pen width button 
or (on Handheld PCs and Palm-Size PCs only) tap ‘X’ to close the toolbar without 
changing the current pen width. 

 

9. Recognize ink (9): sends the current ScratchPad note to the recognition functionality. 
The recognition results are placed on the system clipboard. Navigate to the application 
you want to insert the text into and choose ‘paste’ from its menu (or use the 
CalliGrapher ‘paste’ gesture). 
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NOTE: In order for ink recognition to function properly, your screen ink must consist of 
writing only. 

10. Close ScratchPad (10): closes the ScratchPad window. The drawing you made will not 
be preserved in memory, so save it before exiting CalliGrapher if you’ll need it again.  

Editing Text 

In addition to its remarkable recognition capabilities, CalliGrapher features some advanced 
editing tools. 

Selecting Text 

In Recognition mode, CalliGrapher attempts to recognize any pen input as handwriting.  
Therefore, you need a special means of telling CalliGrapher that you plan to select or drag 
text.  There are two ways to do this: 

! 

! 

Tap and hold the stylus still for a moment until you hear a sound.  At the sound, 
CalliGrapher suspends recognition activities, and your stylus may be used as usual.  
Drag the line across the text you wish to select, in the same way as you would with the 
Eraser tool.  

Draw a line across the desired text and then hold the pen or mouse for a moment.  The 
desired block will be highlighted, and the line you have drawn to select the text will 
disappear. 

Control Gestures 

You may edit text either in the active application’s window, or in CalliGrapher’s own 
Correction Window.  For information on using the Correction Window, please refer to the 
Correction Window section, below. 

To editing text in the active application’s window, use control ‘gestures’, which are 
specially shaped strokes that signal CalliGrapher to perform the appropriate edit function. 

You may use gestures for common operations such as [ENTER], [SPACE], and 
[BACKSPACE].  Many gestures are positional, meaning that their location on the screen 
determines the text affected by the gesture.  If, however, the starting point of the gesture 
does not correspond to a specific place in a paragraph of the text, the desired action will 
be applied at the current cursor location. 

You do not need to draw the arrows that appear on the gesture depictions below.  They 
merely serve to illustrate the end point of the particular gesture.  Gray arrows next to a 
gesture depict the proper method of drawing the gesture. 

Return Gesture 

This gesture is the functional equivalent of pressing [ENTER].  This action 
occurs at the current cursor location. 
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Space Gesture 

This gesture is the functional equivalent of pressing [SPACE].  This action 
occurs at the current cursor location. 

Tab Gesture 

This gesture is the functional equivalent of pressing [TAB]. This action 
occurs at the current cursor location. 

 

Backspace Gesture 

Draw the line from right to left.  This gesture is the functional equivalent of 
pressing [BACKSPACE]. 

Correct Gesture 

This gesture only works outside the CalliGrapher Correction Window.  It opens the 
Correction Window and copies the selected text into it.  Holding the pen or mouse 

for a moment at the end of the gesture copies the entire document into the Correction 
Window.  This operation is particularly useful for spell checking documents. 

For more information on correcting text, please refer to the Correcting Text section, 
below. 

Quick Correct Gesture 

Use this gesture to: 

! 

! 

! 

add a selected word to the dictionary 

open the Correction Window (see the following section) 

If no text is selected, the Quick Correct gesture opens the CalliGrapher Keyboard 
in punctuation layout (see above). 

Case Change Gesture 

Use this gesture over any letter in the Correction Window to change its case.  Begin 
the gesture over the desired letter or symbol, and draw it straight upward. 

In other applications, this gesture changes the case of a selected word or block of text.  It 
can also be used to change the case of the letter immediately after the cursor. 
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Undo Gesture 

Undoes the previous action.  It is the equivalent of pressing [CTRL]+[Z] in most 
Windows applications. 

Copy Gesture 

Copies selected text to the Windows clipboard while leaving the original text in 
place.  It is the equivalent of pressing [CTRL]+[C] in most Windows applications. 

Cut Gesture 

 This gesture removes selected text from the current application and places it in 
the Windows clipboard.  It is the equivalent of pressing [CTRL]+[X] in most Windows 
applications. 

Paste Gesture 

 This gesture copies text previously placed in the Windows clipboard into the current 
application while leaving the text available in the clipboard for repeat pasting, if desired.  
It is the equivalent of pressing [CTRL]+[V] in most Windows applications. 

Correcting Text 

CalliGrapher provides convenient means for text correction both in its own Correction 
Window and directly in other applications’ windows.  Use the ‘Correct’ gesture to copy 
selected text and ‘Correct All’ to copy all document text to the Correction Window.   

The Correction Window allows you to use positional gestures, add or remove text, and 
directly overwrite letters. 
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Correction Window 

When invoked, the Correction Window appears with your selected text copied into it.  The 
Correction Window toolbar has several buttons that aid you in correcting your text: 

Delete Selection Button 

  This button deletes the selected text, or deletes all text if no text is selected. 

Undo/Redo Button 

  Tapping this button alternates between undoing and redoing the previous action. 

Highlight Non-Dictionary Words Button 

  Highlight all words that do not appear in CalliGrapher’s internal dictionaries by 
tapping this button.  This is useful for spell checking and finding non-standard terms and 
jargon. 

Maximize/Restore Button 

  This button alternates the Correction Window between maximized (full screen) and 
window (partial screen). 

Help 

  Opens CalliGrapher help. 

Record Changes Button 

  When you are finished correcting the selected text, tapping this button places the 
corrected text back unto your document and closes the Correction Window. 

Close Correction Window 

   Click this button to close the Correction Window.  You will lose all changes. 

Overwriting Text 

You may correct words by writing the correct letter directly on top of the misspelling, as 
shown below: 

  Word before correction 
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   Overwriting the misspelling 

  Corrected word 

Correction Window Pop-Up Menus  

The Correction Window contains different types of context menus.  Tapping the cursor 
when text is not selected brings up the Word menu.  A single tap on the cursor on a word 
that is selected brings up the Selected Text menu.  Double-clicking on an empty area 
brings up the Non-Text Menu. 

Word Menu 

! Alternative Words: This part of the menu lists recognition alternatives or words 
suggested by the spell-checker.  

! Add Word to Dictionary: Adds the current word to the user dictionary.  This menu 
item displays when the currently selected word is absent from both the user and main 
dictionaries. 

! Case Switch: changes capitalization of the selected character  

! Add Space: adds a space in front of the selected character 

Selected Text Menu  

! Delete Selected: removes selected text and replaces it with a space 

! Replace Selected with Space: inserts a space in place of the selected text 

! Case Switch: changes the capitalization of the whole selection 

! Copy Selected: copies the selected text to the clipboard 

! Paste: inserts the clipboard contents in place of the selection 

Non-text Menu  

! Erase All: clears the Correction Window 

! Undo/Redo: restores text to its state before current correction 

! Copy All: copies contents of the Correction Window to the clipboard 

! Paste: inserts clipboard contents in the Correction Window 

Adding Words to the User Dictionary 

If a word is properly spelled but not found in the main or user dictionaries, you may add 
the word to the user dictionary by selecting the word and using the Quick Correct gesture. 
In this case the CalliGrapher pop-up menu will have an Add to Dictionary option. 
Choose it and the selected word will be added to the dictionary.  (If the word is already in 
the dictionary, this menu will not appear.) 
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Using the Spell Checker 

To spell check part of a document, select the desired text and draw the Correct gesture to 
launch the Correction Window containing your selected text.  Make sure that the 
Highlight Non-dictionary Words button is active.  Words not in the CalliGrapher 
dictionaries appear highlighted and underlined if the highlight non-dictionary words button 
is active.  Make the required corrections and then press the Record Changes button 
(described in the Correction Window section above) to insert the corrected text back into 
the document. 

To spell check the whole document, draw the Correct All gesture to bring all the text in 
the document to the Correction Window. 

RiteCalc 

RiteCalc seamlessly integrates a basic calculator into CalliGrapher’s recognition functions.  
When using Recognition Mode, simply enter a formula as a single sentence with the syntax: 

<operand1><operation> <operand2>…=  

where <operand1> and <operand2> are numbers, and <operation> is the function being 
performed.  You may use multiple terms with the above syntax in one formula (nested 
operations enclosed in brackets are not allowed).  Valid operands include any whole or 
decimal number, with up to two digits after the decimal point and seven digits before it.  

RiteCalc calculates the result using the standard mathematical hierarchy: multiplication 
before division before addition before subtraction.  For example 2*3+5= will yield 11 
(2*3=6, 6+5=11). 

Valid operations are: 
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! Addition: + 

! Subtraction: - 

! Multiplication: * or x. 

! Division: /, :, or ÷   

To use RiteCalc, simply write an equation:   
 

PenCommander 

CalliGrapher 6.0 includes new PenCommander technology, which allows you to perform 
many functions (PenCommands) such as editing or inserting text, opening applications, and 
virtually any function by simply writing a word command and drawing a circle around it.  
Please refer to the table below for a list of pre-recorded PenCommands included with 
CalliGrapher 6.0.   

In addition to the pre-recorded PenCommand commands, you may create your own.  These 
may be simple or complex.  Please refer to the Part Five: PenCommander Reference 
section below for details on creating your own PenCommands. 

You may embed the Text Only PenCommands (see table below) in your writing, just as you 
do with control gestures. 

List of CalliGrapher PenCommands 

The following table list the PenCommands included with CalliGrapher 6.0. They are 
supplied mostly as samples to become the basis for your own set of PenCommands.  

NOTE: Some of the provided PenCommands may not work in some text fields and 
applications. 

 

PenCommand 
Name 

Function 

Text Substitution PenCommands 

addr Types in an address 

btw Types in ‘by the way’  

sign Inserts signature information 

smile ☺ 

tm  
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PenCommand 
Name 

Function 

Date and Time 

time Types in the current time using the 
current locale settings 

date Types in the current date 

Text Edit PenCommands 

all Select all  

copy Copy selected to clipboard([CTRL]+[C]) 

cut Cut selected to clipboard ([CTRL]+[X]) 

paste Paste selected ([CTRL]+[V]) 

undo Undo ([ALT]+[BKSP]) (not on pocket PCs) 

find Find text [CTRL]+[F] 

Application Launch PenCommands 

calc Start Windows Calculator program 

cln Start Calendar application 

mail Open Mail application 

sol Run Solitaire game 

task Start Tasks application 

word Run MS Word application 

run Prompts you for a program name, then 
runs that program 

CalliGrapher-related PenCommands 

spell Selects all text and opens the Correction 
Window 

cor Opens the Correction Window (equivalent 
to the Correct gesture) 

opt Opens the CalliGrapher Options dialog 
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PenCommand 
Name 

Function 

menu Opens the CalliGrapher Main Menu 

lss Starts Letter Shape Selector 

pencmd Open PenCommander Editor 

clip Places clipboard contents into string #9 

Math functions (brings up a math function window with 
the result) 

pow Bring N to the power of P, where N is the 
first number in the selected text and P is 
the second one 

root Calculates the square root of N, where N 
is the number in the selected text 
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Part Four: Customizing CalliGrapher 
This section describes how to set CalliGrapher to suit your individual needs and 
preferences. 

CalliGrapher Options 

To customize CalliGrapher, open the CalliGrapher Main Menu and select Options.  Select 
CalliGrapher as the Input method (Pocket PCs only).  The CalliGrapher Options 
Window appears.  It has the following tabs: 

! General: General CalliGrapher options tab. 

! Configure: This tab allows you to select the recognition engine and dictionaries. 

! Icons (for Palm-Size and Handheld PCs only):  Select the icons you wish displayed in the 
Windows Taskbar notification area. 

! Ink: Customize the line thickness and color.  

! Notes: This tab allows you to customize how and where ScratchPad notes are saved. 

! Recognizer: Customize the way CalliGrapher recognizes your writing. 

The following sections describe each tab in detail. 

The CalliGrapher Options Window has four buttons on the bottom that appear at all times: 

! OK: Saves changes and exits the CalliGrapher Options window. 

! Apply: Saves changes, but without exiting the CalliGrapher Options window. 

! Cancel: Discards changes and exits the CalliGrapher Options window. 

! Reset: This button restores factory default CalliGrapher options. 
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General Tab 

 

The General tab contains check boxes controlling CalliGrapher sounds, appearance of the 
exit conformation dialog box, appearance of the Introduction Screen at CalliGrapher startup, 
the presence of the IconBar (on Pocket PCs and Palm-Size PCs), and the appearance of the 
ScratchPad icon in the Today window (on Pocket PCs only). 
On Palm-Size PC and Pocket PC devices, the CalliGrapher IconBar is displayed in the SIP area 
when CalliGrapher is active. 

Configure Tab 

 

This tab allows you to select and enable or disable your recognizer and dictionaries. 
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Recognizer 

The recognizer is the software module that actually recognizes your handwriting.  By 
selecting different recognizers, you can customize the way CalliGrapher recognizes your 
writing.  For example, if you write in different languages, you may wish to have different 
recognizers available for use.  Contact PhatWare Corp. to learn about the availability of 
different recognizers. 

Check the Recognizer box to enable the recognizer, and clear it to disable.  You may 
select different recognizers either by typing in the full path to the desired recognizer, or 
by tapping the Browse (…) button and using the standard Windows interface to locate your 
desired recognizer.   

Main Dictionary 

While CalliGrapher is running, it may use up to two dictionaries to increase recognition 
accuracy.  Dictionaries are files that store lists of words.  Thus, the dictionaries help the 
recognizer software transform your handwriting into typed text.  The main dictionary is 
part of the CalliGrapher package and contains tens of thousands of frequently used words.  
If you write in different languages, you may wish to use a main dictionary customized to 
the language(s) you use.  Please contact PhatWare Corp. to find out what main dictionaries 
are available.   

You may select any valid CalliGrapher dictionary file as the main dictionary.  At this time, 
PhatWare Corp. is the only source of main dictionary files.  Note that you cannot edit 
dictionaries supplied with CalliGrapher. 

Check the Main Dictionary box to enable the main dictionary, and clear it to disable.  
You may select different main dictionaries either by typing in the full path to the desired 
main dictionary, or by tapping Browse and using the standard Windows interface to locate 
your desired main dictionary. 

User Dictionary 

The user dictionary performs the same function as main dictionaries.  However, the user 
dictionary is fully created and maintained by the user.    

Check the User Dictionary box to enable the user dictionary, and clear it to disable.  
You may select different user dictionaries either by typing in the full path to the desired 
main dictionary, or by tapping Browse (…) button and using the standard Windows 
interface to locate your desired user dictionary.  The default location of the user 
dictionary is in the My Documents folder. 

NOTE: To create a new user dictionary, you must enter the desired name for the new 
dictionary. 

Edit Button 

This allows you to convert lists of words into custom dictionaries for use with CalliGrapher.  
It may be also used for converting user dictionaries created by the previous version of 
CalliGrapher to the new format.   
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Tapping Edit in the Configure tab allows you to edit the user dictionary via the following 
window: 

 

To add a word, type it in the field on the top of the window and tap Add.  To remove a 
word, select it from in list of words in the bottom field and tap Delete. 

Save your changes by tapping OK, or ignore them by tapping Cancel. 

Icons Tab (for Handheld PCs and Palm-Size PCs only): 

The Icons tab allows you to choose which CalliGrapher icons appear in the Windows 
Taskbar notification area. 

 

Modes Icons 

Check or clear the desired boxes to toggle displaying the Recognition Mode (pen) and 
ScratchPad Mode (marker) icons on and off. 
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! Recognition Mode Icon: When this icon is shaded, CalliGrapher is in Recognition Mode.  
Please refer to the Recognition Mode section, above. 

! ScratchPad Mode Icon: When this icon is shaded, CalliGrapher is in ScratchPad Mode.  
Please refer to the section ScratchPad Mode, above. 

NOTE: When neither the pen nor the marker icons appear shaded, CalliGrapher is in Off 
Mode.  Please refer to the section Off Mode, above. 

Switches Icons 

Check or clear the desired boxes to toggle displaying the Screen Orientation, Keyboard 
On/Off, and Normal/Capital/Numeric Recognition Selector icons on and off. 

! Screen Orientation Icon: Tap this icon to change the screen orientation.  This allows 
you to write at a comfortable angle without sacrificing recognition accuracy. 

! Keyboard On/Off Icon: This icon toggles the hardware keyboard on and off, and is 
useful to prevent inadvertently pressing keys with your hand while you are writing on 
an HPC-type device. 

! Recognition Selector Icon: This icon forces CalliGrapher to recognize text as normal, all 
caps, or numeric. 

Actions Icons 

Check or clear the desired boxes to toggle displaying the CalliGrapher Keyboard, Correct 
Selected Text, Correct All Text, start Letter Shape Selector and PenCommander Editor. 

! CalliGrapher Keyboard Icon: Tap this icon to display the CalliGrapher Keyboard.  Please 
refer to the CalliGrapher Keyboard section, above. 

! Correct Selected Text Icon: Tap this icon to spell check selected text.  Please refer to 
the Correcting Text section, above. 

! Correct All Text Icon: Tapping this icon spell checks the entire document.  Please refer 
to the Correcting Text section, above. 

! Start Letter Shape Selector: This icon is a shortcut to launching the Letter Shape 
Selector utility. Please refer to the description of the Shape Selector, below. 

! Start PenCommander: Tapping this icon launches PenCommander Editor.  Please refer 
to the PenCommander Reference section, below. 

Ink Tab 

The Ink tab allows you to assign custom properties to your CalliGrapher Recognition mode 
electronic ‘ink’.  
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Tap the up and down arrows in the Ink Width field to select the desired width of your 
electronic ‘Ink’.  By tapping Ink Color you can select the desired color of the ink from 
the pop-up menu. 

Notes Tab 

The Notes Tab allows you to customize how and where ScratchPad ink files are saved. 

 

By assigning standard prefixes to saved ScratchPad ink files, you can spot such files at a 
glance when browsing your device’s folders.  You may either leave the default selection, or 
type a new one in the File Prefix for Auto Naming field. 
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Select the folder where you wish to place saved Scratch Pad notes by tapping Browse (…) 
and making your selection. 

Check or clear the Save without prompt box to toggle the save prompt function on 
and off.  When it is enabled, your ScratchPad ink files are saved and the ScratchPad is 
cleared without a prompt.  When it is disabled, you are prompted each time you save your 
ink notes. 

Recognizer Tab 

The Recognizer tab allows you to customize how CalliGrapher recognizes your handwriting. 

 

Check or clear the following boxes to toggle their functions on and off: 

! Add Space After: tells CalliGrapher to insert a space after each recognized word or 
fragment 

! Separate Letters Mode: This mode forces the recognizer to recognize only words 
written in separate letters.  Connected letters will not be recognized if writing in 
script. 

! Speed vs. Quality: This slider allows you to customize how you wish CalliGrapher to 
trade off in speed versus quality of recognition. Moving the slider towards the speed 
end of the scale makes CalliGrapher recognize your handwriting very quickly; however, 
it may contain more errors.  Moving the slider to the quality end of the spectrum 
makes CalliGrapher very accurate, but at a cost in time.  The default slider position is 
usually acceptable for most applications, providing good accuracy with a reasonable 
delay.   

! Recognition Delay: This slider controls the recognition time delay.  It determines how 
long CalliGrapher should wait for you to cross your ‘t’s and dot your ‘i’s before sending 
ink to recognition. If CalliGrapher recognizes your handwriting into typed text too 
quickly, it might be confusing because your writing would disappear too quickly.  Also, 
you would not have enough time to write multi-stroke letters (such as crossing the 
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letter ‘t’).  Therefore, setting an appropriate delay allows you to write comfortably.   
We recommend shortening the recognition delay as you become proficient with 
CalliGrapher. 

Shape Selector 

The Shape Selector allows you to tailor CalliGrapher recognition to suit your unique writing 
style.  This helps improve both the speed and accuracy of recognition. 

 

You can access the Shape Selector from the CalliGrapher Main Menu. 

The Shape Selector screen presents various means of writing numbers, letters, and 
common symbols.  For each letter, number, or symbol, tap each possible variation to see 
the animated writing pattern and check the appropriate box to tell CalliGrapher if you use 
that variation Often, Rarely, or Never. You may tap the letter, number, or symbol you 
wish to customize, or you may use the scroll arrows to move through the list.  Close Letter 
Shape Selector when finished.  Your settings are automatically saved. 

You can export and import current writing profiles to and from files using File>Import and 
File>Export.  The writing profile files have .lss extensions. 

If you accidentally enter erroneous settings, you can tap File>Use Original Settings 
to restore the factory defaults. 

You may use two sets of settings: Master and Guest.  This allows you to share your device 
with another person and tailor CalliGrapher to each unique style of writing.  To select a 
list, tap File>Master or File>Guest.
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Part Five: PenCommander Reference 
PenCommander is a new feature within CalliGrapher 6.x, which allows you to launch pre-
recorded, user-defined commands (PenCommands).  PenCommander features are available 
only while CalliGrapher is in Recognition mode. 

What is a PenCommand? 

A PenCommand is a sequence of instructions that are performed when a command is 
called.  Each PenCommand has a name.  The name can be any sequence of ASCII symbols 
up to 11 symbols. It cannot start with ‘#’ or ‘*’.  Examples of correct PenCommand names 
include:  “select”, “address”, “sel”, “phones”, “spell”, “date”, “news”, “mail”, and 
“a23”.  Incorrect names include: “my_home_address” (too long), “#account” (starts with 
‘#’), and “*test” (starts with ‘*’).  PenCommand Names are case insensitive.  For example, 
“BTW”, “Btw” or “btw” are all recognized as the same name. 

There are various categories of elementary instructions that can be used to build 
PenCommands. For example,   “type predefined text”, “start program”, “delay 
execution”, “call user defined function”, “open CalliGrapher’s menu” etc.   

Examples of PenCommands: 

! 

! 

! 

! 

! 

! 

! 

Add name, address, and phone number to the current text of a document; 

Insert special symbol (e.g. ©, ®, ¥, ™…) to the text; 

Select all text in the current document and copy it to the clipboard; 

Open a spreadsheet file, e.g. “PHONES.XLS”; 

Create a new mail message; 

Open “System” item in Control Panel; 

Print the current document; 

PenCommands are written in PenCommander Script. A simplified form of PenCommand is a 
“Text Only” command.  To create and edit Text Only PenCommands, you do not need to 
know the scripting language.  It is highly recommended that you confine yourself to Text 
Only PenCommands at the first stage.  
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Launching PenCommands 

Make sure the CalliGrapher is in Recognition Mode.   To launch a PenCommand, write and 
encircle its name: 

 

             
PenCommand      Result 

PenCommander execution process 

PenCommander interprets instructions from the definitions of its commands one by one 
until the end of the definition.  Some instructions can return a non-success return code 
(e.g. “Load library”,  “Ask variable” etc.), in which case the execution of a PenCommand 
interrupts and the error handler instruction is performed (if defined). 

Text Only PenCommands 
 

The simplest form of PenCommand enters a predefined or user-defined text into the 
current document. Such commands are called  “Text Only” PenCommands.  The predefined 
text can contain any printable symbols as well as tabulations and new-line symbols.  

Following are some examples of Text Only PenCommands: 

PenCommand “sign” 
 
Name: 
       sign 
Comment: 
       // My signature 
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Text: 
 John Smith 
 Vice President & General Manager 
 AnySoft Inc. 
 Tel. (408) 555-1212 
E-mail: john@anysoft.com 

PenCommand “addr” 
 
Name: 
       addr 
Comment: 
       // my address 
Text: 
1234 Stevens Creek Blvd., 
Cupertino, CA 95014 

PenCommand: “sinc” 
 
Name: 
       sinc 
Comment: 
       // sincerely yours 
Text: 
Sincerely yours, 
       John Smith 

You do not need to know the PenCommander script language to create and edit Text Only 
PenCommands.  The PenCommander Editor has a dedicated Text Only Mode to build such 
commands, as described below. 
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Building PenCommands 

All information about existing PenCommands is stored in the file PENMACROS.MCR, which is 
located in the CalliGrapher folder.  PenCommander Editor is the program that allows you 
to edit this file by altering, adding or deleting PenCommands. 

Starting the PenCommander Editor 

To start PenCommander Editor, either select the item PenCommander in the CalliGrapher 
Main Menu or run the program PENCMD.EXE, which is located in the CalliGrapher folder.  
The PenCommander Editor dialog box will appear: 

 

 
  PenCommander Editor dialog box on Pocket PCs 

Comment 
field 

 
 PenCommander Editor dialog box on Handheld PCs 

Comment 
field 

Body 
PenCommander Editor Buttons 

! Add: add new PenCommand 
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! Delete: delete selected PenCommand 

! Edit: edit selected PenCommand 

! Import: load list of PenCommands from a .MCR file 

! Export: save list of PenCommands to a .MCR file 

! Help: open PenCommander Help (Handheld PCs only) 
On Pocket PCs and Palm-Size PCs, use the Help command in the Start menu. 

! Text only mode/Advanced mode: toggles between PenCommander Text Editor and 
PenCommander Script Editor 

! Enable: enables/disables selected PenCommand (as indicated by prefix '+' or '~' before 
the Name of a PenCommand) 

PenCommander Editor Fields 

! PenCommands: list of PenCommands 

! Comment: user defined comment 

! Body: text or script of the PenCommand definition (Handheld PC only). 

Building Text Only PenCommands 

The following dialog box will appear as the result of tapping the Add or Edit buttons in 
Text Only Mode: 
 

 

Text 
field 

! OK: add/update PenCommand; 

! Cancel: cancel. 

You can enter new line symbols to the Text field by pressing Enter and tabulations by 
pressing [CTRL]+[TAB]. 
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Building Script Pen Commands 

The following dialog box will appear as the result of tapping the  Add or Edit buttons in 
the Advanced Mode: 
 

 

Script 
field 

! Keywords: insert Commands, Special Symbols, or PenCommand Name keywords into the 
script.  

 
Command menu example. 
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Special symbol menu example. 

! File Path: inserts the full path of a desired file. 

! Record:  Activates the recording of the keystrokes made on the keyboard. 

! Coordinates:  Allows you to record screen position.  Tap on the crosshairs with the pen 
and drag it to some location on the screen.  When you lift the pen, screen coordinates of 
the last pen position will be inserted in the script.  This is useful if you wish to emulate 
mouse clicks from your PenCommand. 

PenCommander Script Language 

PenCommand Definition (extension) describes the sequence of instructions comprising the 
command. Its format: 
 
<CommandID_1>[Parameters1] <CommandID_2>[Parameters2] … 
<CommandID_N>[ParametersN]  
Command_X – command identifier ( e.g. “#type”, “#start”,  “#delay”) 
ParametersX – parameter string, which consists of ASCII text and special 
symbols; 
<>- angular brackets are part of script syntax for commands and special 
symbols ; 
 [ ] – square brackets mean optional element; 

Command ID and special symbol names are case insensitive. 

Examples of single-instruction PenCommand Definitions include: 
 
<#start>pword “\My Documents\phones.doc”    (start Pocket Word  Application 
with \My Documents\phones.doc file); 
 
<#type>Sincerely yours,<*return><*tab>John  (type “Sincerely yours,”, 
then type “John” on new line after tabulation). 

The last example includes two special symbols <*tab> and <*return>.  

New line symbols (CR-LF) in script text are ignored, you can use them anywhere to make 
text more easy readable, e.g. the example above can be written this way: 
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<#type>Sincerely yours,<*return> 
<*tab>John 

To insert the symbol “<” into the parameter string, write “<<”, for example: 
 
<#type>sometimes 1<<2          (type “sometimes 1<2”) 

Some examples of more complex PenCommand definitions: 
<#macro>all (call PenCommand with name “all”; 
<#delay>1000 then make delay for 1 sec.; 
<#corr> then open CalliGrapher’s Corrector Window); 
 
<#askstr>Enter program file name: (ask program name through dialog and place 
answer to string <#start><*str> then execute program with name from the 
string variable) 

The last example uses “string variable”.  Variables will be discussed in the next section. 

Variables 

There are some internal variables, which can be used in the parameter area of a 
PenCommand script: 

! 

! 

! 

10 text strings up to 256 symbols length (<*str0>-<*str9>) 

10 one character symbols (<*symb0>-<*symb9>) 

10 integers (<*int0>-<*int9>) 

You can omit index digit 0 (e.g. <*str> is equal to <*str0>).  Examples of variables usage 
include: 
 
<#macro><*str>(perform PenCommand with name from string0); 
 
<#type>Sincerely yours,<*return><*str8> (type “Sincerely yours,”, then type 
string8 content on the next line). 
 
<#Start>”C:\Program Files\Apps\<*str3>.exe”   (start program with name from 
string3, which is located in C:\Program Files\Apps\  folder); 

Commands for variables manipulation: 
 
<#SetStr>, <#SetSymb>, <#SetInt>   (set value to appropriate variable); 
 
<#AskStr>, <#AskSymb>, <#AskInt>   (show dialog box to ask variable value); 

Special Symbols 

Special symbols to use in <#Type> command only. 
 

<*ctr_dn>  - Press [CTRL] 
<*ctr_up>  - Release [CTRL] 
<*alt_dn>  - Press [ALT] 
<*alt_up>  - Release [ALT] 
<*shift_dn> - Press [SHIFT] 
<*shift_up> - Release [SHIFT] 
<*bksp>  - Type [BACKSPACE] 
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<*tab>  - Type [TAB] 
<*return>  - ype [ENTER] T
<*right>  - Type [RT ARROW] 
<*left>  - Type [LEFT ARROW] 
<*down>  - Type [DN ARROW] 
<*up>  - Type [UP ARROW] 
<*home>  -  Type [HOME]
<*end>  - Type [END] 
<*pgdn>  - Type [PG DN] 
<*pgup>  - Type [PG UP] 
<*esc>  - Type [ESC] 

Examples: 
 
<#type><*ctr_dn>z<*ctr_up> (Type [CTRL]+[Z]) 
 
<#type>Sincerely yours,<*return>John  (Type “Sincerely yours,” + new 
line + “John”) 

Commands 

This section lists available commands: 

General commands 

Comment 

! 

! 

! 

! 

Keyword: <#> 

Parameters: Any text string (symbol ‘<’ should be doubled) 

Action:  None. 

There is another form of Comment-command: you can place double slash “//” in the 
beginning of line. In this case whole following line will be treated as comment, for 
example: 

 
<#> This is the comment. 
// PenCommand to place the address 

Type 

Keyword: <#Type> 

! Parameters: Any text string, including Special Symbols and Variables. 

! Action: Emulates keyboard activity (e.g. for text input). 

! Remarks: Parameter string for this command can include Special Symbols (e.g. 
“Escape”, “Home”,”BackSpace” etc). 

Examples: 
 
<#type>John Smith type “John Smith”) 
 
<#type><*str> (type String0  
variable) 
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<#Type> My address:<*return> (type “My Address: 1234 California 
Street,<*return> 1234 California Street, Cupertino, CA 5014<*return> 
Cupertino, CA 95014”) 
 
<#Type><*ctr_dn>c<*ctr_up> (type Ctr+C) 
 
<#Type><*alt_dn>f<*alt_up>o {type Alt+F and then type ‘o’) 
 
<#Type><*alt_dn>T<*alt_up><*down><*down><*return> (type Alt+T ; then twice 
‘cursor down’; then ‘Entr’) 

Execute program (Open file) 

! Keyword: <#Start> 

! Parameters: Path to the file to open or execute  + [optional parameter string for 
starting program] 

! Action: Start program 

! Remarks: If file name includes spaces – use quotes.  Program parameters should be 
separated from program name by the space symbol. 

For example: 
 
<#Start>c:\windows\notepad.exe (start Notepad.exe) 
 
<#Start>notepad (start Notepad.exe) 
 
<#Start>notepad “C:\My Documents\phones.txt”  (start Notepad.exe and open  
“C:\My Documents\phones.txt” file) 
 
<#Start>“C:\My Documents\test.txt” (open  “C:\My Documents\test.txt” file 
(non-CE)) 
 
<#Start>pxl  \LoanCalculator.pxl (Open LoanCalculator.pxl in Pocket Excel) 

Execute PenCommand 

! Keyword: <#Macro> 

! Parameters: Name of the PenCommand to execute. 

! Action: Execute a PenCommand. 

! Remarks: The next PenCommand will be processed after this step of execution. Not 
more than 10 PenCommand execution levels can be nested. No recursion is allowed. 

For example: 
 
<#Macro>all (perform the PenCommand ‘all’) 
 
<#Macro><*str3> (perform the PenCommand with its name taken from the 
variable String3) 

Make a Delay 

! Keyword:  <#Delay> 

! Parameters: Time interval for delay (in milliseconds) 

! Action: Make a delay 
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! Remarks: This command usually is used to give the system some time to perform the 
previously asked action before performing the next script command  (e.g. wait after 
<#start> command). 

For example: 
 
<#Delay>1000  (wait 1 second) 

Show Message Box 

! Keyword: <#ShowMsg> 

! Parameters: Text to show in the message box. 

! Action: Shows Message Box with the given text.  

! Remarks: You can use symbol sequence ‘\n’ to force the new line in the message. 

For example: 
 
<#showmsg>Ready to go.      
 
<#showmsg>Error while performing  the PenCommand <*str7>. 

Set Error Handler 

! Keyword: <#DoIfErr> 

! Parameters: Name of a PenCommand to execute. 

! Action: Save name of a PenCommand as the error handler name. 

! Remarks: This command sets the PenCommand name as an error handler. If the 
subsequent instructions in current the PenCommand definition return an error code 
(e.g. <#LoadLib> could not load user library), than the error handler PenCommand will 
be executed (if defined).  This setting is good only for the PenCommands currently 
being executed and has no effect upon the nesting ones.  

For example: 
<# DoIfErr >%loaderr (Set error handler PenCommand name to “%loaderr” 
<#LoadLib>mylib.dll Load library0  “mylib.dll” 
 
<# DoIfErr >%caller Set error handler PenCommands name to “%callerr” 
<#CallLib>myfunc Call user defined  
procedure “MyFunc” from library0 
 
<# DoIfErr > Turn of error handling  (no handling defined) 
<#FreeLib> Free Library0 ) 

 
Variable Manipulation Commands 

Set String Variable 

! Keyword: <#SetStr0> - <#SetStr9> 

! Parameters: String to place to the string variable 

! Action: Set the appropriate string variable to given value. 
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! Remarks: Variable index 0 can be omitted. 

For examples 
 
<#SetStr>John Smith  (Set String0 to the value  “John Smith “) 
 
<#SetStr4><*str3>\myfile.txt  (Set String4 to the concatenation String3 and 
“\myfile.txt” to string4). 

Set Symbol Variable 

! Keyword: <#SetSymb0> - <#SetSymb9> 

! Parameters: Character to place to the symbol variable 

! Action: Set the appropriate symbol variable to given value. 

! Remarks: Variable index 0 can be omitted. Only the first symbol from Parameters area 
is using. 

For example: 
 
<#SetSymb> ™ (Set Symbol0 to ‘™’) 
 
<#SetSymb2>N (Set Symbol2 to ‘N’) 

Set Integer Variable 

! Keyword: <#SetInt0> - <#SetInt9> 

! Parameters: Number to place to the integer variable 

! Action: Set the appropriate integer variable to given value. 

! Remarks: Variable index 0 can be omitted.  

For example: 
 
<#SetInt>1000 (Set Integer0 variable to 1000) 

Ask String Variable 

! Keyword: <#AskSymb0> - <#AskSymb9> 

! Parameters: Title text to show in the dialog box. 

! Action: Show dialog box for string value input. Set the appropriate string variable to 
given value. 

! Remarks: Variable index 0 can be omitted. Current value of variable will be shown in 
the input field of dialog box. 

For example: 
 
<#AskStr4>Please enter program file name: 

Ask Symbol Variable 

! Keyword: <#AskSymb0> - <#AskSymb9> 

! Parameters: Title text to show in the dialog box. 
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! Action: Show dialog box for symbol value input. Set the appropriate symbol variable to 
given value. 

! Remarks: Variable index 0 can be omitted. Current value of variable will be shown in 
the input field of dialog box. 

For example: 
 
<#SetSymb4>k (Set default value – “k” 
 
<#AskSymb4>Enter first letter for searching:   Place result to Symbol4 
variable). 

Ask Integer Variable 

! Keyword: <#AskInt0> - <#AskInt9> 

! Parameters: Title text to show in the dialog box. 

! Action: Show dialog box for integer value input. Set the appropriate integer variable to 
given value. 

! Remarks: Variable index 0 can be omitted. Current value of variable will be shown in 
the input field of dialog box. 

For example: 
 
<#AskInt2>Please, Enter Zoom Percent: (Place result to Integer0 variable) 

User-Defined Procedure Commands. 

Load User Library (DLL file) 

! Keyword: <#LoadLib0> - <# LoadLib9> 

! Parameters: Path to user dll-file to load. 

! Action: Loads dll-file. 

! Remarks: Library index 0 can be omitted. If file name includes spaces – use quotes.   

For example: 
 
<#LoadLib>\mylib.dll  
 
<#LoadLib>”\my documents\mylib.dll” 
 
<#LoadLib><*str8> 

Free User Library 

! Keyword: <#FreeLib0> - <#FreeLib9> 

! Parameters: Ignored. 

! Action: Frees dll-file. 

! Remarks: Library index 0 can be omitted. 

For example: 
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<#LoadLib> 
 
<#LoadLib3> 

Call Procedure from User Library 

! Keyword: <#CallLib0> - <#CallLib9> 

! Parameters: Calling procedure name  [optional parameters string for procedure]. 

! Action: Calls user defined procedure from proper dll-file. 

! Remarks: Library index 0 can be omitted. Procedure name and parameters string must 
be separated by the space symbol. User defined procedure has access to internal 
PenCommand variables and can change them.  

For example: 
 
typedef TCHAR MCR_STRINGS_TYPE[10][256]; 
typedef TCHAR MCR_SYMBS_TYPE[10]; 
typedef INT   MCR_INTS_TYPE[10]; 
typedef _declspec(dllexport) BOOL UserProcName 

(MCR_STRINGS_TYPE *pStrings,  
  MCR_SYMBS_TYPE *pSymbs,  
  MCR_INTS_TYPE *pInts,  
  TCHAR *pParmStr   ,

LPARAM lParam); 

Parameters pStrings, pSymbs, pInts are the pointers to arrays of PenCommand variables. 
The variables may be read or changed by the function. 

Parameter pParmStr points to optional parameters string. 

Parameter lParam is reserved, currently not used. 

Result: non-zero for OK. 

Sample user-defined procedure 
PenCommand Name: TIME 

 
// PenCommand for typing the current Time 
<#LoadLib>D:\Cgr98\macrousr.dll  (Load User Library) 
<#CallLib>UsrPutTimeToStr 5 0 (Call user defined function UsrPutTimeToStr, 
which puts current time in American style to String5 variable) 
<#FreeLib>    (Free User Library) 
<#Type> <*str5>    (type String5 content) 

User-defined function text: 
 
_declspec(dllexport) BOOL UsrPutTimeToStr( 
MCR_STRINGS_TYPE *pStrings,  
MCR_SYMBS_TYPE *pSymbs,  
MCR_INTS_TYPE *pInts,  
TCHAR *pParmStr,  
LPARAM lParam) 
{ 
 int    iStrNum = 0;  //target string number 
 int    iFormat = 0;  //time format (0-American; non-0 - European) 
 SYSTEMTIME st;       //struct for GetLocalTime() 
 
   //read target string number and time format type 
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   if(pParmStr==0 ||  
      _stscanf(pParmStr, TEXT("%d %d"), &iStrNum, &iFormat)<1 || 
      iStrNum<0 || iStrNum>9) 
      return FALSE; 
    
   GetLocalTime(&st); 
    
   if(iFormat==0)  
      { //American time format 
        TCHAR AmPm; 
        int   iHour; 
         if(st.wHour>=12) 
            AmPm = 'P'; 
         else 
            AmPm = 'A'; 
         if((iHour=st.wHour%12)==0) 
            iHour = 12; 
         wsprintf((*pStrings)[iStrNum], "%d:%02d %cM.", iHour, 
(int)st.wMinute, AmPm); 
      } 
   else 
      { //European time format 
         wsprintf((*pStrings)[iStrNum], "%d:%02d", (int)st.wHour, 
(int)st.wMinute); 
      } 
 
   return TRUE; 
} 

 

A full source code of the macrousr.dll can be download form PhatWare’s web site at 
http://www.paragraph.com/download.html. 

CalliGrapher commands 

Show CalliGrapher Menu 

! Keyword: <#Menu> 

! Parameters: Ignored. 

! Action: Shows CalliGrapher Main Menu. 

For example: 
 
<#Menu> 

Show CalliGrapher Options 

! Keyword: <#Options> 

! Parameters: Ignored. 

! Action: Shows CalliGrapher Options Dialog Box. 

For example: 
 
<#Options> 

Show CalliGrapher Corrector Window 

! Keyword: <#Corr> 
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! Parameters: Ignored. 

! Action: Opens CalliGrapher Corrector Window. 

! Remarks: This command has the same result as “Correct”-gesture in CalliGrapher.   

For example: 
 
<#Corr> 

Start Letter Shape Selector 

! Keyword: <#Shape> 

! Parameters: Ignored. 

! Action: Starts CalliGrapher Letter Shape Selector program. 

For example: 
 
<#Shape> 

Script Samples. 

Below are a few useful samples of PenCommand definitions: 

Select all text (for Word) 

PenCommand name: ALL 
 
// Select all text (Ctrl+A) 
// this PenCommand works in Word 
<#type><*ctr_dn>a<*ctr_up> 

You can easy implement some [CTRL]+… PenCommands, such as Copy ([CTRL]+[C]), Cut 
([CTRL]+[X]), Undo ([CTRL]+[Z]), Paste ([CTRL]+[V]) etc. 

Select all text (for most text edit apps) 
PenCommand name: ALL 
 
//Select  all text 
<#Type><*ctr_dn><*home><*shift_dn><*end><*shift_up><*ctr_up> 

Open Corrector Window 
PenCommand name: SPELL 
 
// Open Corrector Window for all current document 
// first: select all text (see the PenCommand in sample2) 
<#Macro>all 
// then open corrector window 
<#corr> 

Open Favorite Internet WEB page 

PenCommand name: WEB 
  
// Open CalliGrapher WEB page 
<#Start>iexplorer http://www.paragraph.com/ products/internetink/calligrapher/ 
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Open CalliGrapher Help 

PenCommand name: CHELP 
 

// Open CalliGrapher help 
<#Start>iexplorer \windows\calligrapher.htm 

Call PenCommander Editor 

PenCommand name: CHELP 
 

// Call PenCommander Editor 
<#Start>”\program files\calligrapher\pencmd.exe” 

Open Inbox 

PenCommand name: INBOX 
//open inbox 
<#Start>pMail 

Open Pocket Excel Spreadsheet 

PenCommand name: LOAN 
 

// Call Loan Calculator 
<#Start>pxl ”\My Documents\LoanCalculator.pxl” 

Place the ‘™’ Symbol into Text 

PenCommand name: TM 
 

// Place the ‘™’ symbol into text. 
<#Type>™ 

CalliGrapher Reserved PenCommands 

There are three PenCommand names, which are reserved for CalliGrapher usage:  

! 

! 

! 

@CgrOnInit 

@CgrOnClose 

@CgrVars 

@CgrOnInit. 

@CgrOnInit is executed (if present) by CalliGrapher while PenCommander PenCommands 
are loading to the system.  You can place any commands within this PenCommand that you 
wish executed at that time. 

For example: 
 
//do it on init 
<#ShowMsg>PenCommander is ready 
<#loadlib3>”\Program Files\myfolder\usrmacro.dll” 
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@CgrOnClose. 

@CgrOnInit is executed (if present) by CalliGrapher while closing PenCommander.  You can 
place any commands within this PenCommand that you wish executed at that time. 

For example: 
 
//do it on close macros 
<#ShowMsg>PenCommander is off 
<#FreeLib3>”\Program Files\myfolder\usrmacro.dll” 

@CgrVars. 

This PenCommand is automatically generated by CalliGrapher when PenCommander is 
closing.  It allows to CalliGrapher to save and restore variable values.  Do not correct this 
PenCommand manually. 
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